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GII-6: GEODEZIJA IR KARTOGRAFIJA GIS SISTEMOSE 1 LABORATORINIS DARBAS 

PRADŽIA. ŽEMĖLAPIŲ KŪRIMAS ARCGIS PROGRAMA 

Atlikimo terminas: darbui atlikti reikia maţdaug savaitės 

Praktinio darbo vertinimas: Šis praktinis darbas vertinamas iki 27 balų, jo vertė sudaro 7 proc. viso kurso 

bendro paţymio. 

 

APRAŠYMAS IR UŢDAVINIAI 

Šis praktinis darbas skirtas tam, kad susipaţintumėte, kaip sudaromi ţemėlapiai ArcGIS programa, ir 

išmoktumėte naudotis pagrindinėmis ArcGIS programų paketo komponentų ArcMap ir ArcCatalog 

funkcijomis. Atlikdami aprašytus veiksmus, stenkitės galvoti, ką darote, o ne vien mechaniškai vykdyti 

nurodymus. 

 

Šiame darbe kursite Vilniaus dalies ţemės paskirties / ţemės dangos (LU/LC) ţemėlapį. Susipaţinsite su tam 

tikrais kartografijos principais ir išmoksite juos taikyti dirbdami ArcMap programa. Jūsų Vilniaus dalies 

ţemėlapyje bus vaizduojami tam tikri baziniai topografiniai elementai. 

 

Baigę šį darbą, turėtumėte suprasti šiuos terminus ir sąvokas: 

 ArcMap, ArcCatalog 

 Ţemėlapio dokumentas 

 Ţemėlapio sluoksniai 

 Ţemėlapio savybės 

 Ţemėlapio mastelis 

 Duomenų sritis 

 Teminiai ir geografiniai ţemėlapiai 

 Legendos formavimas 

 Nominalinių duomenų vaizdavimas 

 Elementų ţymės 

 Ţemėlapio sandara ir maketo elementai 

 

ATSISKAITYMO REIKALAVIMAI 

Šios uţduoties atsakymus į visus klausimus ir ţemėlapį reikia pateikti per BlackBoard nuotolinio mokymo 

sistemą. Baigtą ţemėlapį įrašykite į grafinį failą VilniusLULC_Map.jpg ir įterpkite šį failą į naujai sukurto 

dokumento į kurį įkopijuosite uţduoties klausimus su atsakymais pabaigą (MS Word programoje Insert > 

Picture > From file… (įterpti > paveikslą > iš failo), suraskite savo VilniusLULC_Map.jpg, paţymėkite ir 

spustelėkite Insert (įterpti)). Išsaugokite dokumentą doc, rtf arba pdf formatais. 

 

PASIRUOŠIMAS 

Elektroniniai vadovai 

Tie mokymo dalyviai, kurie yra įsidiegę ArcGIS programinę įrangą gali naudotis ir visais ArcGIS vartotojo 

vadovais, kurie programos įdiegimo  metu yra įkeliami į C:\Program Files\ArcGIS\Documentation katalogą. 

Šiuose vadovuose pateikiama puiki mokomoji medţiaga apie kiekvieną ArcGIS komponentą ir jo plėtinius, o 

taip pat jais galima naudotis kaip ţinynais. Jie padės jums atlikti kurso uţduotis ir suteiks galimybę 

savarankiškai tyrinėti kitus ArcGIS aspektus.  
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Duomenys  

GIS failus iš  laikinojo GII06_1 aplanko į savo c:\Data mokymosi aplanką kopijuosite ArcCatalog programa. 

ArcCatalog yra viena iš ArcGIS paketo programų. Pagrindinės ArcGIS programos yra ArcCatalog ir ArcMap. 

Jos abi turi ArcToolbox. 

 

Darbas su ArcCatalog 

 

1) Paleiskite ArcCatalog per Windows paleisties meniu: Paleistis > Programos > ArcGIS > ArcCatalog (Start > 

Programs > ArcGIS > ArcCatalog). Jūs pastebėsite, kad ArcCatalog panašus į Windows Explorer. 

ArcCatalog programa skirta padėti naršyti, tvarkyti ir skirstyti GIS duomenų failus. Vietiniai standieji diskai 

išvardinti kairiajame viršutiniame polangyje, o dešiniajame gali būti failų sąrašas (Contents kortelė), 

momentinis duomenų rinkinio atvaizdis (Preview kortelė) arba informacija apie duomenų rinkinį, 

pavyzdţiui, kas ir kada jį sukūrė (Metadata kortelė). 

 

2) Kairėje pusėje bus rodomas C: diskas. Jei norite prisijungti prie kito, nerodomo disko, turite nurodyti, kur jis 

yra; spustelėkite ArcCatalog Connect to Folder mygtuką  ir pasirinkite diską. 

 

3) Savo kompiuterio C: disko Data aplankale ArcCatalog programa sukurkite GII06_1\ aplanką (dešiniuoju 

pelės mygtuku spustelėkite C:\Data > New > Folder > surinkite pavadinimą GII06_1). 

 

4) Jei norite sumaţinti pelės spustelėjimų, galite prisijungti ne tik prie disko, bet ir prie bet kurio aplanko, kurį 

norite matyti pagrindiniame kairiajame polangyje. Pabandykite prisijungti prie sukurto GII06_1 aplanko 

( ). Vienas iš tokio prisijungimo pranašumų tas, kad lengva prieiti prie tų pačių duomenų – nereikia kaskart 

kartoti tuos pačius veiksmus, skirtus duomenų aplankui pasiekti. 

 

5) Nukopijuokite visus duomenis iš laikinojo GII06_1 aplanko  (tai yra tie patys duomenys, tačiau norėta, kad 

tuos pačius ţingsnius atliktumėte įprastomis priemonėmis ir ArcCatalog) į šių mokymų GII06_1 aplanką 

(C:\Data\GII06_1\). ArcCatalog programa galima kopijuoti duomenis ir kompiuteryje, ir tinkle.  

 

Pastaba: GIS failus kopijuokite arba perkelkite tik ArcCatalog programa. Kodėl? Tai, kas jums 

ArcCatalog programoje atrodo vienas sluoksnis ar failas, iš tikrųjų gali būti keli failai. Kai 

kopijuojate ar keliate failus su ArcCatalog, programa užtikrina, kad bus nukopijuoti visi 

reikalingi failai. Be to, GIS failų duomenų struktūra gan įmantri; kartais faile gali būti įrašyta jo 

saugojimo vieta. Kopijuodama ar perkeldama failus, ArcCatalog atnaujina šią informaciją ir 

įrašo naująją failų vietą. Jei failus tiesiog pertempsite pele Windows sistemoje, ši informacija 

atnaujinta nebus – taip galima ir sugadinti failą. ArcGIS neparodys jums specialaus pranešimo 

apie tai, bet vėliau gali pradėti rodyti keistus klaidų pranešimus be jokios aiškios priežasties. 

 

6) Kairiame viršutiniame ArcCatalog polangyje spustelėkite pliuso ţenklą šalia GII06_1 aplanko ir išplėskite 

vaizdą. Pamatysite kelis dalykus. 
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Antrasis yra GRID – rastrinių duomenų sluoksnis. Kiti GII06_1 aplanke išvardinti dalykai yra SHAPE failai 

– vektoriniai taškų , linijų  arba poligonų  sluoksniai. 

 

Daugiau informacijos apie ArcCatalog ieškokite ESRI skaitmeniniame vadove UsingArcCatalog (darbas su 

ArcCatalog). 
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PRATIMAS  

Tarp tolesnių nurodymų pateikti klausimai, kurie paskatins jus pagalvoti apie kiekvieną pratimo veiksmą. 

Nesistenkite atlikti pratimo labai greitai: per skubėjimą daţnai praleidţiami kurie nors veiksmai ir 

pridaroma nereikalingų klaidų. Jei kiekvieną veiksmą apgalvosite ir suprasite, kas vyksta, bus daug 

lengviau ištaisyti galimas klaidas. Jei padarytumėte klaidą, kruopščiai atšaukite atliktus veiksmus atgaline 

tvarka, kol ją surasite. Paprastai nereikia pradėti visko iš naujo nuo pat pradţios (nebent pamirštumėte 

saugoti atliktus veiksmus). Šioje dalijamojoje medţiagoje palikta vietos jūsų atsakymams. 

 

7) Paleiskite ArcMap per Windows paleisties meniu: Paleistis > Programos > ArcGIS > ArcMap (Start > 

Programs > ArcGIS > ArcMap). Kai ArcMap pasileis, pasirodys klausimas, ką daryti toliau; 

paţymėkite „A new empty map“ (naujas tuščias ţemėlapis) ir spustelėkite OK (gerai). 

 

8) Pakeiskite duomenų srities (Data frame) pavadinimą (numatytasis pavadinimas yra 'Layers') į 

'Vilnius': vieną kartą spustelėkite duomenų srities pavadinimą ir surinkite naują pavadinimą 

. Išsaugokite ArcGIS ţemėlapio dokumentą  savo darbiniame aplanke GII06_1 

pavadinimu Vilnius.mxd. 

 

Žemėlapio dokumente (.mxd) nėra pačių ţemėlapio duomenų. Ţemėlapio dokumente saugoma tik 

informacija, kur rasti ţemėlapį sudarančius failus (t. y. failų keliai), ir kaip juos rodyti (pvz., greitkelius 

rodyti stora raudona linija). Vienas iš ţemėlapio dokumento pranašumų yra tas, kad jame nesaugomi 

geografiniai duomenys, iš kurių ţemėlapis sukurtas, todėl galima tuos pačius duomenų rinkinius naudoti 

daugeliui ţemėlapių dokumentų, ir nereikia saugoti kelių geografinių duomenų kopijų, kurios gali uţimti 

labai daug vietos. 

 

Pastaba: jei perkelsite kuriuos nors ţemėlapio dokumente išvardintus failus į kitą 

vietą, kai atversite ţemėlapio dokumentą kitą kartą, programa neţinos, kur jų ieškoti. 
Apie tai programa praneš raudonu šauktuku (!) šalia ArcMap ţemėlapio sluoksnio. Jei taip 

nutiktų, dešiniuoju pelės mygtuku spustelėkite ArcMap ţemėlapio sluoksnį, pasirinkite 

Data > Repair Data Source… ir naršykle suraskite tikrąją failo vietą. Kad teisingas failo 

kelias būtų išsaugotas, išsaugokite ţemėlapio dokumentą. 

 

Vilniaus ţemės paskirties ţemėlapį pradėsime kurti nuo fono; tam panaudosime teminį ţemės paskirties / 

ţemės dangos sluoksnį ir reljefo šešėlių sluoksnį, sukurtą iš skaitmeninio reljefo modelio . Sukursime 

kompozicinį dviejų temų vaizdą: viena tema (ţemės paskirtis / ţemės danga) suteiks spalvas, kita (reljefo 

šešėliai) sudarys aukščio iliuziją. 

 

Vienas iš pagrindinių fono dizaino principų yra kontrastas su figūromis – ant fono vaizduojamais objektais. 

Kontrastas nurodo skirtumo tarp skirtingų objektų laipsnį. Ryškiai iš fono išsiskiriantys objektai yra 

didelio kontrasto, o beveik susiliejantys su fonu – maţo kontrasto. Taigi, kontrastas naudingas figūros ir 

fono santykiams nurodyti. Kontrastą galima pasiekti keičiant spalvą, vertę, raštą ir linijų storį arba simbolio 

dydį. 

 

9) Pridėkite prie ţemėlapio fono sluoksnius: spustelėkite mygtuką Add Data  ir susiradę atverkite savo 

GII06_1 darbinį aplanką. Pridėkite prie ţemėlapio landu_p (ţemės paskirties) elementų sluoksnį. Tada 

tuo pačiu veiksmu pridėkite hillshade (reljefo šešėlių) sluoksnį (spustelėkite „Close the warning dialog 

box“ (uţverti įspėjimo dialogo langą)). Kairėje pusėje esančioje turinio lentelėje (Table of Contents – 

ToC) jūsų žemės paskirties (landu_p) sluoksnis bus virš reljefo šešėlių (hillshade) sluoksnio. 

 

10) Vaizdavimo gylio (Display Depth) nurodymas: dukart spustelėkite (arba spustelėkite pelės dešiniuoju 
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mygtuku > Properties) landu_p sluoksnį, ir atsivers Layer Properties (sluoksnio savybių) dialogas. 

Display (rodymo) kortelėje įveskite '40' proc. skaidrumo vertę. Kad pamatytumėte rezultatą, 

spustelėkite Ok. Dukart spustelėkite hillshade sluoksnį – pasirodys Layer Properties dialogas. 

Įsitikinkite, kad Symbology (simbolikos) kortelėje nurodytas Standard Deviation (standartinio 

nuokrypio) perėjimo tipas. Spustelėkite Ok. Galite dar kartą išsaugoti ţemėlapį (Save). 

Kelias simbolių charakteristikas, daţnai vadinamas vaizdiniais kintamaisiais, galima keisti. Šios 

charakteristikos yra forma, orientacija, raštas, atspalvis, vertė ir grynis. Skaidrumą taip pat galima laikyti 

nauju (elektroniniu) vaizdiniu kintamuoju. 

 

11) Dabar jums reikia į ţemėlapio turinio lentelės viršų įkelti du bazinių hidrografinių elementų (upių) 

sluoksnius. Pridėkite rivers_l (upių) ir hidro_p (upių poligonų) sluoksnius (galima pridėti juos kartu: 

Add Data dialogo lange reikia paţymėti abu SHAPE failus laikant nuspaustą Shift klavišą). 

 

12) Pakeiskite hidrografijos elementų rodymo parametrus (dydţio ir spalvos kintamuosius). Pirmiausia 

dukart spustelėkite hidro_p sluoksnį – atsidarys Layer Properties dialogas. Symbology kortelėje 

spustelėkite didelį numatytojo simbolio mygtuką – atsidarys Symbol Selector (simbolių rinkiklis). 

Pakeiskite hidro_p uţpildo spalvą (Fill color) į šviesiai mėlyną (įprastinė vandens objektų spalva), 

kontūro storį į 0,45, o kontūro spalvą į tamsiai mėlyną. Vietoj to galite pasirinkti nustatytąjį simbolį 

, skirtą eţerų ţymėjimui. Spustelėkite Ok ir dar kartą Ok. 

 

13) Pakeiskite rivers_l sluoksnio vaizdavimo parametrus (jo simbolis turi atitikti hidro_p simbolio 

kontūrus). 

 

Kita ţemėlapių dizaino uţduotis – nustatyti duomenų matavimo skalę. Duomenis galima skirstyti į 

kokybinius ir kiekybinius. Taip pat juos galima aprašyti matavimo skale. Ţemėlapių kūrėjai daţniausiai 

susiduria su trijų skalių duomenimis: nominaliniais, ranginiais ir intervaliniais arba santykiniais. 

 Nominaliniai duomenys yra skirtingų tipų, todėl neįmanoma sudaryti jų hierarchijos. Nominalinių 

duomenų pavyzdţiai: ţemės paskirtis (gyvenamoji, komercinė, parkai) arba medţių rūšys (klevas, 

ąţuolas, eglė). 

 Ranginių duomenų hierarchiją sudaryti galima, tačiau tik santykinę (ţemas, vidutinis, aukštas). Jei 

duomenys ranginiai, galima teigti, kad kuris nors vienas dalykas didesnis uţ kitą; bet kadangi 

elementai neturi skaitinių verčių, skirtumo tarp jų išmatuoti neįmanoma. 

 Intervaliniai / santykiniai duomenys, priešingai, turi skaitmenines vertes. Taigi galima ir rikiuoti 

dalykus pagal tam tikrą tvarką, ir matuoti skirtumus tarp jų. Intervalinių / santykinių duomenų 

pavyzdţiai: aukštis, gyventojų skaičius. 

 

14) Mes kursime poligoninio sluoksnio ţemės paskirties (landu_p) temą pagal normines vertes – ţemės 

paskirties / ţemės dangos (LC/LU) tipus. Pirmiausia išanalizuosite kiekvieno LC/LU atributų 

duomenis: dešiniuoju mygtuku spustelėkite landu_p sluoksnį ir pasirinkite Open Attribute Table 

(atverti atributų lentelę). Kiekvienas šios lentelės įrašas atitinka vieną poligoninį ţemėlapio objektą. Jei 

paţymėsite kurį nors lentelės įrašą (spustelėkite langelį įrašo priekyje 

, ir įrašas bus paţymėtas mėlynai), atitinkamas objektas (pvz., LU/LC 

poligonas) bus paţymėtas ţemėlapyje (jei norite matyti paţymėtą ţemėlapio objektą, dešiniuoju 

mygtuku spustelėkite langelį įrašo priekyje ir pasirinkite Flash (blykčioti) arba Zoom to (didinti iki)). 

Šis objektas taip pat bus apvestas mėlyna linija. Standartinės įrankių juostos (Standard) priemonėmis 

galima panaikinti elementų ţymėjimą (Clear Selected Features)  ir padidinti ţemėlapį iki viso 

vaizdo (Full Extent) . Standartinė įrankių juosta paprastai būna ArcMap ekrane. Jei šios juostos 

nematyti, galima nueiti į View > Toolbars (rodyti > įrankių juostas) meniu ir pasirinkti standartinės 
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(Standard) juostos įrašą. 

 

15) landu_p sluoksnio atributų lentelėje matyti konkrečių LU/LC tipų kodai. Kad suţinotumėte, ką jie 

reiškia, reikia metaduomenų informacijos. Dalį šios informacijos galima rasti lut.dbf lentelėje. Prie 

ţemėlapio turinio lentelės pridėkite lut.dbf perţiūros lentelę iš savo darbinio aplanko. Atverkite ir 

išanalizuokite šią lentelę. lut.dbf lentelėje yra visų 1:50 000 mastelio Lietuvos skaitmeninių ţemėlapių 

elementų kodai. Atkreipkite dėmesį į lauką, kurio pavadinimas CODE – jis panašus į jūsų landu_p 

atributų lentelės stulpelius. 

 

16) Dabar jums reikia sujungti šiuos du duomenų rinkinius: viename yra erdviniai duomenys apie LU/LC 

tipų vietą ţemėlapyje (landu_p), kitame – neerdvinių duomenų lentelė su kodais ir jų aprašais. Dabar 

jums reikia pasinaudoti jungimo komanda (Join) ir sukurti ryšius tarp šių lentelių, kad būtų galima 

ţemėlapyje pavaizduoti neerdvinius duomenis. Dešiniuoju mygtuku spustelėkite landu_p sluoksnį ir 

pasirinkite Joins and Relates > Join… (jungti ir sieti > jungti...). Įveskite informaciją, kurios reikia 

ryšiui tarp landu_p lentelės ir lut.dbf lentelės sukurti (abiems lentelėms pasirinkite atitinkamus laukus, 

kuriuose surašytos kodinės reikšmės), ir spustelėkite OK. 

 

17) Atverkite landu_p atributų lentelę ir išanalizuokite pokyčius. 

 

18) Dabar galima pasirinkti LU/LC tipų simbolius: dukart spustelėkite landu_p sluoksnį – pasirodys Layer 

Properties dialogas. Symbology kortelėje po Show (rodyti) uţrašu pasirinkite Categories > Unique 

Values (kategorijos > unikalios vertės). Vertės lauke (Value field) pasirinkite lut.APRASAS ir 

spustelėkite mygtuką Add All Values (pridėti visas vertes). Galima atţymėti langelį „all other values“ 

(visos kitos vertės). Spustelėkite Apply (vykdyti), ir pamatysite rezultatą. 

1 klausimas. Koks yra žemėlapio mastelis, kai 14 veiksmu iki maksimumo padidinate ArcMap langą ir 

spustelite įrankių (Tools) juostos mygtuką Full Extent (didinti iki viso vaizdo)? Jei šios įrankių juostos 

nesimato, pagrindiniame meniu pasirinkite View > Toolbars > Standard Tools (rodymas > įrankių juostos 

> standartiniai įrankiai). 

 

 

 

 

 

1 

2 klausimas. Kai padidinate žemėlapį ekrane, jo mastelis tampa stambesnis ar smulkesnis? Kodėl? 

 

 

 

 

 

1 

3 klausimas. Ką pastebėjote landu_p atributų lentelėje? Paaiškinkite, kas įvyko ir kodėl. 

 

 

 

 

 

2 

4 klausimas. Pagal kurį lauką jungėte lenteles? Kodėl? 

 
1 
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5 klausimas. Jei dabar atvertumėte landu_p lentelę kitame žemėlapyje, ar ji atrodytų taip pat? Kodėl? 

Kaip visam laikui išsaugoti sąryšį tarp lentelių? 

 

 

 

 

 

2 

6 klausimas. Šiame darbe duomenų klasifikavimo pagrindu imamos dvi kategorijos: žemės paskirtis ir 

žemės danga. Kuo, jūsų manymu, skiriasi šie du terminai.? 

 

 

 

 

 

 

 

2 

19) Reikia pakeisti numatytąsias ArcMap spalvas natūraliomis LU/LC tipų vaizdavimo spalvomis (pvz., 

miškus galima vaizduoti vidutine ţalia spalva, eţerus ir tvenkinius – mėlyna ir t. t.). Jei norite pakeisti 

LU/LC simbolio spalvą, dešiniuoju mygtuku spustelėkite simbolį ir pasirinkite norimą spalvą simbolių 

rinkiklyje (Symbol Selector). Kai baigsite, spustelėkite OK ir vėl išsaugokite (Save) savo ţemėlapio 

projekto dokumentą. 

 

 

7 klausimas. Kokias spalvas priskyrėte? Pateikite visų LC/LU tipų lentelę arba ekrano nuotrauką. 

 

 

 

 

 

 

 

 

3 

20) Savo LU/LC simbolių paletę galite išsaugoti atskiru failu, kad vėliau jūs patys arba kiti galėtų juo 

pasinaudoti. Dešiniuoju mygtuku spustelėkite landu_p sluoksnį ir išsaugokite savo darbiniame aplanke 

kaip sluoksnio failą (Save As Layer File) pavadinimu Landu_Palete. Šį Landu_Palete.lyr failą 

galima importuoti per Symbology kortelę ir panaudoti atitinkamam sluoksniui vaizduoti. 

 

Jau turime Vilniaus dalies LU/LC ţemėlapį, bet orientyrų jame ne per daugiausia. Todėl naudotojui gali 

būti sunku surasti tam tikro LU/LC tipo vietą. Kad ţemėlapio naudotojui būtų lengviau orientuotis 

vizualiai, jums reikia pridėti daugiau bazinės informacijos, kad mūsų vaizduojamoje srityje būtų galima 

orientuotis pagal pagrindinius elementus. Dabar jums prie ţemėlapio reikia pridėti dar du elementus – 

pagrindinius kelius ir gatves bei ţymius miesto objektus. 

 

21) Pridėkite prie savo ţemėlapio roads elementus. Atverkite jų atributų lentelę ir išanalizuokite. 
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roads sluoksnis pasirinktas todėl, kad jis labiau generalizuotas negu 1:50 000 mastelio Lietuvos 

skaitmeninio ţemėlapio keliai, ir neuţdengs LU/LC temos. 

 

22) Atverkite savo darbiniame aplanke esantį GKTR2.03.02_LT.doc failą ir išanalizuokite 2.17.2 lentelės 

GKODAS lauko kodo specifikaciją. Dabar jums reikia patiems įvesti kelių kodo aprašus į roads 

atributų lentelę. Atverkite roads atributų lentelę ir Options (parinkčių) išskleidţiamajame meniu 

pasirinkite Add Field … (pridėti lauką). Pavadinkite naująjį lauką Aprasas, nurodykite tekstinį (Text) 

tipą ir 50 simbolių lauko ilgį ir spustelėkite OK. 

 

23) Option meniu pasirinkite Select by Attribute (atrinkti pagal atributą), šios parinkties dialogo lange 

surinkite išraišką "GKODAS" = 'gc11' ir spustelėkite Apply. Bus paţymėti įrašai ir eilutės, kurių vertė 

yra gc11. Dešiniuoju mygtuku spustelėkite Aprasas lauko antraštę ir pasirinkite lauko skaičiuotuvo 

parinktį (Field Calculator). Mygtuku OK patvirtinkite, kad norite pradėti „ne redagavimo“ („not 

editing“) seansą, ir Field Calculator dialogo lange įveskite išraišką “greitkeliai“, kad paţymėti 

Aprasas laukeliai uţsipildytų gc11 kodo aprašu “greitkeliai“. Spustelėkite OK. 

 

  
24) Tą patį veiksmą pakartokite ir su kitais kodais. Sutvarkę kodų aprašus galite uţdaryti visus dialogų 

langus. Jei reikia, atţymėti paţymėtus elementus galima įrankių (Tools) juostos  mygtuku (jei šios 

juostos nematyti, ją įjungti galima komanda View > Toolbars > Tools (rodymas > įrankių juostos > 

įrankiai)) . 

 

25) Dešiniuoju mygtuku spustelėkite roads temą ir išskleidţiamajame meniu pasirinkite Properties. 

Sluoksnio savybių (Layer Properties) dialogo meniu pasirinkite simbolikos (Symbology) kortelę. 

Kairėje Show lauke spustelėkite Categories (kategorijos) ir pasirinkite Unique Values (unikalios 

vertės). Pakeiskite Value Field (vertės laukas) Aprasas lauku ir spustelėkite mygtuką Add All Values 

(pridėti visas vertes); langelį all other values galima atţymėti. Spustelėkite Apply. 

 

26) Dabar reikia pakeisti numatytuosius ArcMap simbolius tais, kurių reikia mums. Mes bandysime naudoti 

standartinius simbolius, nurodytus Lietuvos 1:50 000 mastelio topografinių ţemėlapių specifikacijoje 

(ţr. GKTR.2.05.01.doc). Galite naudoti panašius simbolius atitinkamiems laukams: 
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gc11 – Greitkeliai  

gc12 – Keliai su danga  

gc14 – Keliai su danga be kieto pagrindo  

gc15 – Gruntkeliai  

 

27) Nustatykite kelio simbolių hierarchiją: greitkelis turi atsidurti sąrašo viršuje, po juo – kelias su kieta 
danga, ir t. t. (pasirinktą kategoriją galite perstumti į viršų ar į apačią dešinėje esančiomis rodyklėmis) 

 
 

28) Pakeiskite kelių kategorijų simbolius. Pabandykite imituoti standartinę 1:50 000 topografinio ţemėlapio 

simboliką. Jei dukart spustelėsite simbolį , atsivers Symbol Selector, kuriame galėsite pasirinkti 

tinkamą simbolį ir pakeisti jo charakteristikas (pvz., spalvą, storį ir kt.). Galite pridėti ir daugiau 

simbolių iš More Symbols išskleidţiamojo meniu (pvz., iš transportavimo (Transportation) paletės). 

 

Nuo ţemėlapio mastelio priklauso detalių skaičius ir simbolių pasirinkimas (pvz., simbolių dydį). 

 

29) Be to, jums reikia ţinoti, kokiu masteliu jūsų ţemėlapis bus spausdinamas ar rodomas. Jei manote, kad 

LU/LC ţemėlapis bus spausdinamas 1 : 50 000 masteliu, privalote padidinti ţemėlapį ir išanalizuoti jo 

dizainą šiuo masteliu. Mastelį galima įvesti standartinės įrankių juostos ţemėlapio mastelio (Map 

Scale) tekstiniame langelyje  įrašius norimą mastelį ir paspaudus klavišą Enter 

(Įvesti), kad pasikeistų ţemėlapio mastelis ekrane. 

 

Nelengva pasirinkti tokius skirtingų kategorijų linijinių elementų simbolius, kad išliktų kontrastas ir 

ţemėlapį būtų lengva ir malonu skaityti. Grafiniai simboliai turi būti lengvai skaitomi ir suprantami. 

Simboliai turi būti aiškiai matomi ir skirtis vienas nuo kito. Pavyzdţiui, 1 mm dydţio simboliai nors ir 

matomi, bet juos sunku atskirti vieną nuo kito. 

 

30) Kai baigsite rinktis kelių simbolius ir tvarkyti jų dizainą, galite išsaugoti kelių paletę kaip sluoksnio 

failą (.lyr) vėlesniam naudojimui. 

8 klausimas. Kelių žemėlapis yra geografinis ar teminis? Pagrįskite atsakymą. 

 

1 
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31) Galiausiai jums reikia prie ţemėlapio pridėti pntobj elementų sluoksnį. Šiame sluoksnyje yra baţnyčių, 

geleţinkelio stočių, oro uostų, skridimo aikščių ir kitų svarbių objektų padėtys. Jums reikia pntobj 
atributų lentelėje sukurti naują 50 simbolių ilgio tekstinį lauką šių objektų pavadinimams. Pavadinkite 

šį naująjį lauką Vardas. 

 

32) Tada sujunkite pntobj atributų lentelę su lut.dbf lentele taip, kaip tai darėte anksčiau su landu_p 
sluoksniu 16 žingsnyje . 

 

33) Dabar klaviatūra įvesite svarbiausių Vilniaus objektų pavadinimus. Pirmiausia, padarykite lentelę 

redaguojamą. Pridėkite į ArcMap darbalaukį redaktoriaus (Editor) įrankių juostą (View > Toolbars > 

pasirinkti Editor įrankių juostą). Editor išskleidţiamajame meniu pasirinkite Start Editing 

 (pradėti redaguoti). Pasirinkite aplanką, kuriame yra pntobj SHAPE failas, ir 

spustelėkite OK. 

 
 

34) Atsidarykite pntobj atributų lentelę ir paţymėkite pirmąjį jos įrašą bei suraskite paţymėtą tašką 

ţemėlapyje. Įrašykite paţymėto elemento pavadinimą atributų lentelės Vardas lauko langelyje. Šį 

pavadinimą galite surasti Internete ar suţinoti iš kitų šaltinių; galite vadovautis ir savo pačių ţiniomis 

apie vietovę. Atlikite šią uţduotį visiems 24 pagrindiniams Vilniaus objektams. Išsaugokite taisymus 

Editor išskleidţiamojo meniu Save Edits komanda ir baikite redaguoti to paties meniu Stop Editing 

komanda. 

 

35) Panašiai, kaip keitėte kelių simbolius, pakeiskite objektų simbolius pagal objektų tipų kategorijas (iš 

lut.APRASAS lauko). Galima atţymėti langelį all other values. Galima naudoti ArcMap paletėse 

esančius asociatyvius arba iliustruotus simbolius. Objektų simbolius galite išsaugoti kaip sluoksnio 
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failą (.lyr). 

 

Asociatyvūs simboliai – tai simboliai, kurių forma paprastai yra uţuomina į vaizduojamą objektą (pvz., 

kryţius ligoninėms arba taisyklingai išdėstyti taškai kupstais augančiai ţolei vaizduoti). Iliustruotų arba 

mimezinių simbolių forma atitinka vaizduojamą objektą. 

Svarbi informacijos perdavimo uţduotis yra ţymių (label) išdėstymas ţemėlapyje. Tekstinės ţymės yra 

svarbus temos vaizdavimo komponentas. Ţymės tinka nurodyti skaitytojui geografinės atskaitos taškus, kad 

jis galėtų identifikuoti temos objektus. Jei pagal jūsų ţemėlapį sunku nustatyti objektų padėtį, niekas juo 

nesinaudos. 

 

ArcMap programa tekstines ţymes objektams gali priskirti pagal jų atributus, arba tekstą galima surinkti 

patiems kompiuterio ekrane. Be to, yra specialūs ţymių stiliai – figūrinės išnašos, ţenkleliai prieš tekstą, 

reklamjuostės, greitkelių ţenklai ir daug kitų. Pridėjus tekstinę ţymę, sluoksnio savybių (Layer Properties) 

dialogo ţymių (Labels) kortelėje galima pakeisti jos spalvą, dydį ir šriftą arba ţymių (Labeling) įrankių 

juostos ţymių tvarkykle (Label Manager) galima tvarkyti visas vienos srities ţymes ir naudoti Maplex 

plėtinį. 

 

36) Dabar jums reikia sudėti uţrašus svarbiausiems objektams. Atverkite pntobj sluoksnio savybių (Layer 

Properties) dialogą (t. y. dukart spustelėkite sluoksnį). Ţymių (Labels) kortelės laukų sąraše 

paţymėkite Vardas; ţymių stilių (Label Styles) sąraše pasirinkite City (miesto) stilių ir spustelėkite 

OK; pakeiskite įvesto teksto šriftą į 8 dydţio Bold (pastorintą) Arctic White spalvos  

Arial. Spustelėkite OK, ir jūsų ţymių stilius bus pakeistas. 

 

Tekstas visada turi būti kontrastingas fonui. 

 

37) Dešiniuoju mygtuku spustelėkite pntobj sluoksnį, tada spustelėkite Label Features (priskirti 

elementams tekstines ţymes). Ţymės bus išdėstytos ţemėlapyje taip, kaip nurodyta numatytosiose 

ArcMap išdėstymo nuostatose. Jei norite pagraţinti bendrą ţemėlapio dizainą, galite pakeisti ţymių 

stilių (spalvą, šriftą ir pan.). Pagerinti ţymių išdėstymą ir dizainą galima naudojantis papildomomis 

ArcMap parinktimis ir Maplex plėtiniu. To mokysimės kituose laboratoriniuose darbuose. 

 

38) Išsaugokite (Save) savo ţemėlapio dokumentą. 

 

9 klausimas. Koks skirtumas tarp žemėlapio dokumento ir duomenų failo? Jei perkelsite duomenų failą į 

kitą aplanką ir tada atversite žemėlapio dokumentą, kaip žemėlapio dokumente atrodys atitinkamas 

duomenų sluoksnis? Kodėl? 

 

 

 

 

 

 

 

2 

39) Spustelėkite Full Extent mygtuką, kad ekrane pasirodytų visas ţemėlapis. Įrankių (Tools) juostoje 

spustelėkite paieškos (Find) įrankį ir įsitikinkite, kad pasirinkta elementų (Features) kortelė. Paieškos 

(Find) langelyje surinkite Pavilnio ir spustelėkite mygtuką Find (rasti). Paieškos rezultatai pasirodys 
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dialogo lango apačioje. Dešiniuoju mygtuku spustelėkite įrašą ir pasirinkite Zoom to Feature(s) (didinti 

iki elemento (-ų)). Jei norite greitai nustatyti, kuris tai objektas, dešiniuoju mygtuku spustelėkite 

paieškos rezultatą ir pasirinkite Flash Feature (blykčioti elementą). Uţverkite paieškos (Find) dialogo 

langą. 

10 Kokio tipo kelias eina šalia Pavilnio? 

 

 

 

1 

40) Įrankių juostos mygtuku Full Extent (didinti iki pilno vaizdo) atstatykite pradinį ţemėlapio mastelį, kad 

būtų parodyta visa ţemėlapio sritis. Paieškos (Find) įrankiu suraskite Mickūnų geleţinkelio (Mickunu 

railway) stotį ir Vilniaus geleţinkelio (Vilnius railway) stotį. Dešiniuoju mygtuku spustelėkite Vilnius 

duomenų sritį, pasirinkite Properties… (savybės) ir General (bendrąją) kortelę. Pakeiskite ekrano ilgio 

vienetus į kilometrus (Kilometers) ir spustelėkite OK. 

 

11 klausimas. Koks tiesus  atstumas tarp šių geležinkelio stočių? 

 

 

 

1 

Pakeitę duomenis taip, kaip jums patinka, atlikite paskutinį veiksmą – sukurkite maketą. Maketas – tai 

dokumentas, kuriame pateikiami jūsų rezultatai. Maketą paprastai sudaro ţemėlapis (jūsų projekto 

ţemėlapio rodinys (Map view)) ir galbūt lentelės, diagramos ir maketo elementai, pavyzdţiui, legenda ir 

mastelis. 

Yra daug ţemėlapio elementų, kuriuos derėtų pridėti prie jūsų ţemėlapio. Reikia išlaikyti vaizdinę šių 

elementų hierarchiją – labiausiai į akį krentantys elementai turėtų būti patys svarbiausi. Vakarų gyventojai 

skaito iš viršaus ţemyn ir iš kairės į dešinę, taigi elementus pagal svarbą ţemėlapyje reikia išdėstyti 

atitinkamai. Kiti pagrindiniai ţemėlapių dizaino principai yra balansas, figūros ir fono santykis bei 

kontrastas. 

 

Galutiniame ţemėlapyje gali būti šie maketo elementai: 

 Ţemėlapis arba Objekto sritis – turėtų būti didesnė uţ visas kitas, ir turinys turėtų būti perteiktas 

tinkamais simboliais. 

 Pavadinimas – antros eilės pagal svarbą; nurodo pagrindinę ţemėlapio paskirtį arba turinį ir 

konkrečią vietą bei laiką. Skirtas pranešti auditorijai ţemėlapio temą. 

 Legenda – pagalbinis pavadinimo elementas, kuriame aprašyti visi neţinomi arba unikalūs 

ţemėlapio simboliai. 

 Ţemėlapio mastelis – trečios eilės pagal svarbą kaip dizaino elementas, bet pateikti jį reikia – jis 

padeda ţemėlapio skaitytojui orientuotis. 

 Įdėtinis vaizdas – gali tikti tam tikroms sritims pavaizduoti stambesniu masteliu arba apţvalginiam 

vaizdui. 

 Informacija apie autorius – trečios eilės pagal svarbą kaip dizaino elementas, bet ją reikia nurodyti 

ţemėlapio duomenų šaltinyje (taip pat ir patikimumą bei datas). 

 Geografinių arba stačiakampių koordinačių tinklelis – geografinė ţemėlapyje vaizduojamos 

srities atskaitos sistema, padedanti jums ir jūsų ţemėlapio skaitytojams pagal ţemėlapį nustatyti 

objektų padėtį. 

 Kraštinės ir rėmeliai – elementų hierarchijoje uţima ţemiausią vietą ir skirti akių judėjimui 

ţemėlapiu riboti. 

 Šiaurės rodyklė – taip pat ţemiausia pagal hierarchiją, nurodo ţemėlapio orientaciją. 
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ArcMap programoje ţemėlapio elementai kuriami ir išdėstomi virtualiame puslapyje – vadinamajame 

„makete“. Jei nenurodyta kitaip, naujame sukurtame makete parodomos turinio lentelės duomenų sritys. 

Galima nurodyti, kurie sluoksniai bus rodomi maketo duomenų srityse – reikia įjungti ar išjungti tuos 

laukus turinio lentelėje. 

 

Kiti ţemėlapio elementai, pavyzdţiui, šiaurės rodyklė, pavadinimas ir legenda, taip pat rodomi duomenų 

srityse. 

 

Visi maketo elementai turi savybes, kurias galima pakeisti pagal savo poreikius. Pavyzdţiui, galima 

pakeisti ţemėlapio pavadinimo šriftą ir dydį, galima nurodyti, kurie sluoksniai bus rodomi legendoje, 

pakeisti duomenų sričių fono spalvą, pridėti elementų kraštines, sulygiuoti elementus bei pakeisti ţemėlapio 

lapo dydį ir orientaciją. 

 

Jums nebūtina kurti maketo nuo pat pradţios. Galima pasinaudoti mygtuku Change Layout (keisti maketą) 

, esančiu Maketo (Layout) įrankių juostoje, ir pasirinkti maketo šabloną. Šablone maketo elementai jau 

išdėstyti. Pakeisti jau sukurtą išdėstymą gali trukti trumpiau, negu sukurti naują. 

 

Kad sukurtumėte maketą, reikės spustelti pagrindinėje juostoje rodymo (View) meniu komandą Layout 

View (maketo rodinys) 

  arba pasirinkite Layout View mygtuką ţemėlapio lango apačioje esančioje 

juostoje . Ţemėlapio elementus į maketą galima įdėti iš įterpimo (Insert) meniu. 

 

41) Kai sluoksnių išvaizda sukurta, laikas juos sudėti į ţemėlapio maketą. Pirmiausia jums reikia uţfiksuoti 

1:50 000 spausdinimo mastelį: dukart spustelėkite Vilniaus duomenų srities  piktogramą, 

duomenų srities (Data Frame) kortelėje pasirinkite fiksuotą mastelį (Fixed Scale), teksto langelyje 

įveskite 1:50 000 ir spustelėkite OK. Dabar pastebėsite, kad ekrane ţemėlapio neįmanoma nei padidinti, 

nei sumaţinti (ekrano mastelio keitimo valdikliai pilki). Mastelis uţfiksuotas. 

 

42) Toliau jums reikia pakeisti maketo puslapio sąrankos (Page Setup) parametrus: spustelėkite File > 

Page and Print Setup (failai > puslapio ir spausdinimo sąrankos) meniu, ir pasirodys puslapio ir 

spausdinimo sąrankos (Page and Print Setup) dialogas. Atţymėkite langelį Use Printer Paper Setting 

(naudoti spausdintuvo popieriaus nuostatas) ir nustatykite A1 ţemėlapio lapo dydį (Map Page Size) ir 

stačią (Portrait) lapo orientaciją. Paţymėkite langelį Scale Map Elements proportionally to changes in 

Page Size (keisti ţemėlapio elementų dydį proporcingai lapo dydţio pokyčiui) ir spustelėkite OK. 

 

 
 

43) Kol kas mes dirbome ArcMap duomenų rodinyje (Data View). Ţemėlapių maketai kuriami maketo 

rodinyje (Layout View). Įjunkite maketų rodinį (Layout View) rodymo (View) meniu maketo rodinio 

(Layout View) komanda arba po pat duomenų langu esančiu maketo rodinio mygtuku (Layout View, 
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). Jūsų duomenų sritis bus automatiškai pridėta prie ţemėlapio maketo. Kitus elementus 

(pavyzdţiui, mastelio juostą ir šiaurės rodyklę) pridėti ir jų padėtį nustatyti reikia rankiniu būdu. 

Mygtuku Refresh View  (atnaujinti rodinį) galima perbraiţyti ţemėlapio maketą iš naujo. 

 

44) Dabar į ţemėlapio maketo sritį jau įdėtas bazinis ţemėlapis. Elementų pasirinkimo (Select Elements) 

įrankiu  galima paţymėti sritį (spustelėti ją) ir stumti pelės ţymeklį sritimi tol, kol jis pavirs 

keturkrypte rodykle, o tada, laikant nuspaustą pelės mygtuką, nutempti ţemėlapį į naują vietą lapo 

viduryje. 

 

Maketo (Layout) įrankių juostos įrankiais galima atlikti įvairius veiksmus su maketu – keisti mastelį ir pan. 

Ši juosta skirta maketo elementams. . Ją 

įkelti į ekraną galima iš tos pačios vietos: View > Toolbars (rodymo > įrankių juostų) meniu. 

Jei pavaizduotas geografinių arba stačiakampių koordinačių tinklelis, lengviau įsivaizduoti ţemėlapio 

aprėpiamą sritį. 

 

45) Jums reikia pridėti prie ţemėlapio stačiakampių koordinačių tinklelį: ţemėlapio turinio lentelėje dukart 

spustelėkite Vilniaus duomenų sritį ir pasirinkite tinklelių (Grids) kortelę. Spustelėkite mygtuką New 

Grid… (naujas tinklelis). Jums reikia sukurti metrinį stačiakampių koordinačių tinklelį, dalinantį ţemėlapį į 

ţemėlapio vienetus. Paţymėkite stačiakampio tinklelio (Measured Grid) parinktį ir spustelėkite Next 

(toliau). Išvaizdos (Appearance) lange paţymėkite parinktį Label only (tik ţymė), nurodykite 10 000 metrų 

intervalą (Intervals) ir spustelėkite Next. Kituose languose spustelėkite Next, Finish (baigti) ir OK. 

 

Vilnius ţemėlapio sritis bus susieta su atitinkamu stačiakampiu tinkleliu. 

 

Kad ţemėlapio skaitytojams būtų lengviau suprasti pagrindinio Vilniaus ţemėlapio simbolius, jums reikia 

sukurti ţemėlapio legendą. 

 

46) Turinio lentelėje pakeiskite pntobj, roads ir landu_p sluoksnių pavadinimus tais, kuriuos norite matyti 

ţemėlapio legendoje. 

 

47) Įterpimo (Insert) meniu pasirinkite legendos komandą (Legend). Šiai legendai reikia tik pntobj, roads 

ir landu_p sluoksnių. Laikydami nuspaustą Ctrl klavišą, legendos elementų (Legend Items) lange 

paţymėkite visus kitus sluoksnius. Spustelėkite kairiosios rodyklės mygtuką  ir pašalinkite juos. 

 

48) Išdėstykite legendos elementus šia tvarka: landu_p, pntobj ir roads. Nurodykite, kad legenda turės 2 

stulpelius. Spustelėkite Next (toliau). 

 

49) Legendos pavadinimo (Legend Title) lange pakeiskite numatytąjį pavadinimą į „SUTARTINIAI 
ŽENKLAI“ (didţiosiomis). Spustelėkite Next (toliau). Nustatykite 1,5 taško legendos rėmelio kraštinės 

(Border) storį ir baltą (White) foną (Background). Perkelkite legendos vedlį (Legend Wizard) taip, kad 

matytumėte ir jį, ir pagrindinę ţemėlapio duomenų sritį. Spustelėkite Preview (perţiūra). 

 

50) Perţiūrėkite legendą (rodoma maţdaug ties duomenų srities viduriu). Spustelėkite Finish (baigti). 

 

51) Makete perkelkite pagrindinio ţemėlapio legendą į ribinio stačiakampio apačią. Jei reikia, pakeiskite 

legendos dydį (ji neturėtų uţdengti kitų elementų). Jei norite keisti legendos išvaizdą ir elementus, dukart 

spustelėkite legendą ir pakeiskite jos savybes. 
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Ţemėlapio elementų simboliai legendoje turi atrodyti visiškai taip pat, kaip ţemėlapyje. 

52) Dabar reikia sukurti ţemėlapio pavadinimą, mastelio juostą ir šiaurės rodyklę. Sukurkite ţemėlapio 

pavadinimą: spustelėkite įterpimo (Insert) meniu komandą Title (pavadinimas). Pavadinimas pasirodys ties 

duomenų srities viršumi. Pakeiskite ţemėlapio pavadinimo tekstą į „ŽEMĖS PASKIRTIS IR ŽEMĖS 
DANGA, Vilnius, 2007 m.“. Pavadinimas turi atspindėti ţemėlapio paskirtį. 

 

53) Dukart spustelėkite pavadinimą ir pakeiskite jo savybes: pavadinimą išdėstykite dviejose eilutėse; 

pakeiskite simbolių (Change Symbol) dydį į 60, šriftą – į pastorintą (Bold), spustelėkite OK ir sucentruokite 

eilutes. Spustelėkite OK. 

 

54) Elementų pasirinkimo (Select Elements) įrankiu  perkelkite pavadinimą į jo duomenų srities viršaus 

centrą. 

 

55) Sukurkite mastelio juostą: spustelėkite įterpimo (Insert) meniu komandą Scale Bar (mastelio juosta) ir 

pasirinkite Alternating Scale Bar 1 (1 pasikartojantis grafinis mastelis). Spustelėkite Properties (savybės). 

Mastelio ir vienetų (Scale and Units) kortelės mastelio srities (Scale Area) dalyje spustelėkite ţemyn 

nukreiptą rodyklę po uţrašu When resizing (keičiant dydį) ir pasirinkite Adjust number of divisions 

(koreguoti padalų skaičių). 

 

56) Atkreipkite dėmesį, kad padalos vertės (Division Value) laukas tampa aktyvus. Nurodykite, kad padalos 

vienetai (Division Units) bus kilometrai (Kilometers). Įveskite 5 km padalos vertę (Division Value). Šios 

nuostatos reiškia, kad mastelio juosta padalinama į 5 km atitinkančias dalis. Be to, jei keisite mastelio 

juostos dydį, juosta didės arba maţės 5 km ţingsniu – lygiu jos padalos vertei. Pakeiskite tekstinę ţymę 

(Label) į „Km“, o padalų dalinimo skaičių (Number of Subdivisions) į 2. Spustelėkite formato (Format) 

kortelę ir pakeiskite teksto dydį į 14. Įveskite juostos storį: 8. Spustelėkite OK ir dar kartą OK. 

 

57) Dabar reikia pakoreguoti mastelio juostos dydį ir padėtį. Pakeiskite mastelio juostos padėtį taip, kad 

juosta atsidurtų dešiniajame apatiniame duomenų srities kampe. 

 

58) Įterpkite šiaurės rodyklę: spustelėkite įterpimo (Insert) meniu komandą North Arrow (šiaurės rodyklė) 

ir pasirinkite ESRI North Arrow 16 (ESRI šiaurės rodyklė). Spustelėkite OK. Elementų pasirinkimo (Select 

Elements) įrankiu  gerokai ją sumaţinkite ir perkelkite į dešinįjį viršutinįjį duomenų srities kampą. 

 

Kai sukelsite į maketą visus reikiamus elementus, neskubėdami parinkite jų dydį ir tinkamai išdėstykite 

juos ţemėlapio lape bei vienas kito atţvilgiu; reikia atsiţvelgti į elementų „svorį“ (hierarchiją), vaizdinį 

elementų balansą, ţemėlapio vaizdinį centrą ir bendrą išvaizdą. Jūsų tikslas – sukurti tokią kompoziciją, 

kuri leistų skaitytojams sutelkti dėmesį į svarbiausią ţemėlapio informaciją ir tuo pat metu išryškintų 

pagalbinę informaciją, kurios reikia ţemėlapiui suprasti. 

 

59) Elementų pasirinkimo (Select Elements) įrankiu  kilnokite elementus po maketą, kol gausite 

geriausią ţemėlapio išvaizdą. Pagrindinio ţemėlapio geometrinis centras turi sutapti su ţemėlapio vaizdiniu 

centru. Vaizdinis centras yra maţdaug 5 proc. aukščiau, negu geometrinis lapo centras. 

 

5% of height
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Pagrindinis ţemėlapis yra svarbiausias maketo elementas ir uţima didţiausią maketo dalį. 

 

Standartinės teminių ţemėlapių pavadinimo vietos nėra. Pavadinimo vieta parenkama tokia, kad 

pavadinimas turėtų tam tikros svarbos, o visa kompozicija būtų geriausiai subalansuota. Jei pavadinimas yra 

daugiau negu vienos eilutės, jo eilutes reikia lygiuoti centru. Tarp eilučių reikia palikti tarpus. Paprastai 

pagrindinė pavadinimo dalis rašoma didesniu, sunkesniu, pastorintu šriftu arba didţiosiomis raidėmis; 

likusi dalis rašoma maţesniu, lengvesniu, šriftu. Pavadinimas yra suprantamas kaip vienas blokas, kurį 

dizaino sumetimais galima stumdyti po maketą. 

 

Legendos, arba sutartinių ţenklų, vieta ţemėlapyje parenkama taip, kad būtų gautas geras vaizdinis 

balansas. Ji gali būti su rėmeliu arba be rėmelio. Galima manyti, kad tai tik maţytė dizaino uţduotis; 

svarbiausia, kad legendos elementai būtų išdėstyti aiškiai ir tinkama tvarka. Legenda daţnai turi 

pavadinimą, pabrėţiantį viso ţemėlapio pavadinimą. Legendoje reikia pateikti visus ţemėlapio simbolius, 

kurie nėra savaime suprantami; šie simboliai ir legendoje, ir ţemėlapyje turi atrodyti visiškai vienodai. 

 

Visuose ţemėlapiuose derėtų pateikti mastelį, bet kuriant ţemėlapį reikia atminti, kad mastelis yra tik 

pagalba skaitytojams, o ne svarbiausias ţemėlapio elementas. Todėl jam nederėtų skirti aukščiausios vietos 

vaizdinėje hierarchijoje. 

Rėmelį reikia pridėti paskutinį, kai visi kiti elementai yra savo vietoje. Rėmelis brėţiamas aplink kai 

kuriuos arba aplink visus ţemėlapio elementus. Rėmeliai atskiria kartografinius elementus vieną nuo kito ir 

daro ţemėlapius lengvesnius skaityti. Jei rėmelis nubrėţtas aplink visą ţemėlapį, ţemėlapis atrodo 

„uţbaigtas“. 

 

60) Pridėkite rėmelį prie ţemėlapio: spustelėkite įterpimo (Insert) meniu komandą Neatline (rėmelis), 

paţymėkite parinktį Place around all elements (aplink visus elementus) ir pasirinkite dvigubą graduotą 

(Double, Graded) kraštinės stilių bei tuščią (Hollow) foną. Spustelėkite OK. Elementų pasirinkimo (Select 

Elements) įrankiu  pakeiskite rėmelio dydį, kad rėmelis tilptų į ţemėlapio lapą: spustelėkite rėmelį ir 

traukite rankenėlę. 

 

Jei norite pakoreguoti atskirų elementų ar sričių (pvz., legendos) išvaizdą arba padėtį, naudokitės komanda 

Convert to Graphics (konvertuoti į grafinį formatą). Kai sritis konvertuoti į grafinį formatą ir 

išgrupuojama, galima pasirinkti atskirus grafinius komponentus ir pakeisti jų savybes, pavyzdţiui, simbolį, 

spalvą ir padėtį. Galima, pavyzdţiui, redaguoti atskirus legendos ir mastelio juostos komponentus. 

 

Kaip suţinojote atlikdami šį pratimą, maketo elementai, pavyzdţiui, legendos, šiaurės rodyklės ir masteliai 

įkeliami į maketo sritis. Jei norite pataisyti į sritį įkeltą dokumento dalį, konvertavimo į grafinį formatą 

(Convert to Graphics) komanda galite dokumento sritį padalinti į atskirus grafinius komponentus. Ši 

komanda yra išskleidţiamajame meniu, kuris atsiveria spustelėjus elementą dešiniuoju mygtuku. Tada 

galima redaguoti bet kurią dokumento dalį. 

 

Bet atminkite, kad supaprastinta duomenų sritis nebėra dinamiškai susieta su savo pirminiu dokumentu. Ji 

tampa nepriklausomai redaguojamų ir kilnojamų grafinių elementų rinkiniu. Jei pataisę norite perkelti visą 

supaprastintą elementą, pirmiausia reikia elementų pasirinkimo (Select Elements) įrankiu  paţymėti visus 

jo komponentus ir grupavimo (Group) įrankiu juos sugrupuoti. Grupavimo įrankis yra išskleidţiamajame 

meniu, kuris atsiveria spustelėjus elementą (-us) dešiniuoju mygtuku. 

 

Jei reikia sukurti kelis ţemėlapius pagal tą patį bendrą maketą, galima sukurti maketo šabloną. Maketo 

šablonai leidţia įrašyti maketo elementus į failą, kurį vėliau galima panaudoti kuriant kitus maketus. 

 

61) Sukurkite maketo šabloną: spustelėkite failų (File) meniu komandą Save As (įrašyti kaip) ir įrašymo 
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tipo (Save As Type) lange nurodykite ArcMap templates (*.mxt) (ArcMap šablonai (*.mxt)). Atverkite savo 

darbinį aplanką ir pavadinkite šabloną Sablonas_Vilnius. Spustelėkite Save (įrašyti). 

 

62) Kai atliksite visą šį darbą, reikės eksportuoti maketą į grafinį arba PDF failą. Eksportuotą vaizdą galima 

įterpti į ataskaitą arba dauginti. Maketą galima eksportuoti į bet kurį iš daugelio palaikomų išvesties 

formatų. Failų (File) meniu pasirinkite komandą Export Map (eksportuoti ţemėlapį). Atverkite savo darbinį 

aplanką ir eksportuokite failą JPEG formatu VilniusLULC_Map pavadinimu. Parinkčių (Options) 

kortelėje nustatykite 150 dpi skiriamąją gebą (Resolution), o formato (Format) kortelėje – geriausią JPEG 

kokybę (JPEG Quality). Spustelėkite Save (įrašyti). 

 

63) Jei turite vaizdų apdorojimo arba perţiūros programą, atverkite ja VilniusLULC_Map.jpg failą ir 

paţiūrėkite, kaip jis atrodo. Jei norite pagerinti grafinio failo kokybę, pasirinkite didesnę skiriamąją gebą ir 

(arba) kitą vaizdo formatą. Jūs ţemėlapio kūrimo darbą baigėte, tad išsaugokite ţemėlapio dokumentą. 

ŢEMĖLAPIO DIZAINO SANTRAUKA 

 

GIS ţemėlapio dizaino procesas vadinamas dizaino ciklu. 

 

Ţemėlapis turi: 

 atitikti auditoriją ir paskirtį; 

 būti tikslus – tinkamai atvaizduoti teisingą ir neiškreiptą informaciją; 

 atsiţvelgti į ţmogaus regos apribojimus. 

 

Kurdami ţemėlapio dizainą, įvertinkite: 

 harmoniją – ar elementai gerai atrodo kartu; 

 kompoziciją – elementų išdėstymą ir akcentus; 

 aiškumą – ar naudotojui bus lengva atpaţinti ţemėlapio elementus, ar ţemėlapis įskaitomas ir 

graţus. 

 

12 klausimas. Įterpkite savo VilniusLULC_Map.jpg žemėlapį įvertinimui. 10 

 


